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We updated AquiferWin32/WinFlow to include many features users requested.  We made the application more 
user-friendly and full-featured. Since we continually enhance our software, please let us know if there is a fea-
ture you would like added. As always, all interim releases are free and downloadable from the internet until 
Version 4.0 is available. 
 
The major changes are summarized below: 
 
New Analyses 

• Kipp, 1985 – Type Curve Analysis of Inertial Effects in the Response of a Well to a Slug Test 
• Moench, 1985 - Transient Flow to a Large-Diameter Well in an Aquifer With Storative Semiconfining 

Layers 
• Moench, 1997 - Flow to a well of finite diameter in a homogeneous, anisotropic water table aquifer 
• WinTran - WinTran is designed to be an easy-to-use model for simulating the fate and transport of 

dissolved contaminants in fully saturated groundwater systems. 
 

New Functionality 
• Legend Wizard – Enables easy setup of legends and optionally automatically resizes legend, adds de-

fault parameters and maintains position in the lower right corner of the graph or map 
• On screen editing of items within legends 
• Line Calculations and Distance/Drawdown graphs 
• 3D Perspective in Flow Model 
• Shapefile export of contours, particle traces, streamlines and wells  
• Shapefile maps now supported 

What’s New In Aquifer win32/WinFlow Version 3.0? 
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New Analyses 
 

Kipp, 1985. The Kipp, 1985 analysis is used for slug tests that exhibit a sinusoidal response due to iner-
tial effects. 

 

 
 
 

Moench, 1985. The Moench, 1985 analysis is very versatile and supports all three Hantush aquitard 
boundary types (Constant head, No Flow and Constant Head/No Flow) ) and allows leakage from 
above, below or both.  It also supports a line source well or a finite diameter well including well bore 
storage and well bore skin. 

 

 
 
 

Moench, 1997. The Moench, 1997 analysis allows analysis of pump tests in unconfined aquifers in 
which well bore storage and/or well bore skin are a significant factor. 
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WinTran. WinTran is designed to be an easy-to-use model for simulating the fate and transport of dissolved 
contaminants in fully saturated groundwater systems.  The WinTran model couples the steady-state ground-
water flow model from WinFlow with a contaminant transport model.  The transport model feels like an 
analytic model but is actually an embedded finite-element simulator.  The software automatically constructs 
the finite-element transport so that you may quickly get answers to your groundwater problems. 
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New Functionality 
 
Legend Wizard 
 
One of the most common support issues has been setting up legends and we made this process much easier.  In 
Version 3, adding a legend is as simple as clicking the mouse in the view, clicking the Add->Legend menu and 
dragging a rectangle.  The following wizard is activated to help in setting up the wizard.  If you simply click 
the finish button, a legend will be created containing the pertinent parameters and will be located in the lower 
right corner of the graph or map. 
 
To make a legend as in previous versions, select the Create empty legend radio button and click the Finish but-
ton; double click on the newly created legend box and set it up as you see fit. 
 
The legend generated by the wizard was patterned after the example legends created in the example files 
shipped with previous versions of the program.  The specific legend created using the following example wiz-
ard screens is below. 
 

 
 
 
The legend has three sections, the Title sublegend, the Parameter sublegend and the Symbol sublegend.  The 
Title and Symbol sublegends are optional as is the bitmap in the Title sublegend. 
 
To customize the legend created with the wizard, click the Create custom legend radio button and the Finish 
button becomes a Next button to continue the customization.  Two other options are available via check boxes.  
The Don’t use this wizard for future editing option overrides the default behavior that, when you double click 
the legend to edit it, the wizard will not be used.  The Automatically Adjust and Locate Legend check box con-
trols whether the system will automatically maintain the location of the legend.
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If you chose to create a custom legend, the next step in the wizard enables you to choose the items you want 
added to the legend. The Parameters step presents a list of parameter items which is dynamic and defined by 
the active document type, analysis type and view type.  As with Parameters in previous versions, you drill 
down into the options and click on the item you want, in this case Transmissivity.  Using the Append, Insert 
and Remove buttons, you select what you want.  You can also change the default title for an item by selecting it 
in the right list box and entering the new title in the Title edit field. 
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The Text step of the process controls colors and fonts of the legend title, parameter titles and parameter values.  
It also controls the overall format and precision for parameter values. 
 

 
 
The Styles step defines the layout of the legend including sublegends, border colors and thicknesses, back-
ground colors and title bitmap. 
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The Symbols step is only displayed when the Symbol Sublegend  checkbox has been checked in the previous 
step.  You can control the contents of the symbol sublegend. 
 

 
 
Editing Legends On Screen  
 
If you have created a legend using the legend wizard and have selected the Automatically adjust and locate 
legend option any changes made on screen will be automatically undone when the screen refreshes.  The on 
screen editing features are for older legends, those created as empty legends using the wizard or those that have 
selected the Don’t use this wizard for future editing option. 
 
On screen manipulation now drills into legends no matter how deeply they are nested to allow the typical on 
screen manipulations to be performed.  In addition, a context menu has been created for legends that allows for 
Cut/Copy/Paste/Select All/Delete/Add/Add to Legend operations within the legend. 
 
Of particular note is the Add to Legend menu.  When items have been selected in the main view, they can be 
added to the legend using this menu.  In most cases, you will want to drag the object into the legend and posi-
tion it before using this option.  You can, however, attach items to the legend that are not located inside the 
legend.  When the legend is moved, they maintain their relative position to the legend.  
 
Line Calculations and Distance/Drawdown Graphs  
 
A line calculation is simply a line dragged onto the map view in a Simulation or Flow Model document along 
which head/drawdown calculations will be made and a graph generated.  If one of the end points of the line 
corresponds with a pumping well, a drawdown versus distance graph can be generated. 
 
Line calculation elements appear on the map with similar characteristics to a line and, when the View->Well 
Data menu is checked, a view tab is added for the graph of drawdown versus distance. 
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The specific options available for Line Calculations are as follows: 
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Line Calculation Designator:   Each line calculation must have a unique name so that it can be identified on 
view tabs. 
 
Spatial Parameters 

 
Data Spacing Parameters 
 

Start X:  The x coordinate of the starting point for the line calculation in map coordinates.  
Distances are calculated relative to this point. 

Start Y:  The y coordinate of the starting point for the line calculation in map coordinates.  
Distances are calculated relative to this point. 

End X:  The x coordinate of the ending point for the line calculation in map coordinates. 

End Y:  The y coordinate of the ending point for the line calculation in map coordinates. 
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Line Style 

 
Label Parameters 

Equal Divisions Data points will be calculated at equal intervals between the start and end 
points of the line calculation. 

Number: The number of equal intervals to calculate between the start and end points of 
the line calculations. 

Linear  Data points will be calculated at specified intervals starting at the start point 
of the line calculation. 

Spacing: The spacing, in map units, between adjacent points in the line calculation. 

Log  Data points will be calculated at logarithmic intervals starting at the start 
point of the line calculation. 

Samples Per Decade: The number of logarithmic intervals between adjacent powers of 10 in the 
line calculation. 

Custom Distances, in map units, entered into the spreadsheet on the Data tab will be 
used for the calculations. 

Color: Sets the color of the line connecting the data points  

Thickness: Sets the thickness in points of the line connecting the data points  

Dash: Sets the dash pattern to use for the line connecting the data points  

Length: Sets the length in inches of the dash pattern for the line connecting the data points 
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3D Perspective 
The 3D vertical tab contains the 3D perspective view of the hydraulic head or drawdown  values.  Contour lines 
can be optionally displayed as well.  All the normal annotations can be added; however, the annotations are 
fixed in position in the view and are not moved/rotated when the 3D perspective is manipulated. 
 

Color The color to use when displaying the line calculation label 

Angle The angle to rotate the text when displaying the line calculation label 

Alignment The alignment of the label relative to the label location 

Display Label If checked, the line calculation designator is used to label the well 

Font Defines the font, font style, size and effects for the label  

Label Offsets  

dX: The distance, in map units, to offset the label in x from the x-coordinate of the line 
calculation center point. 

dY: The distance, in map units, to offset the label in y from the y-coordinate of line cal-
culation center point. 
 

 

Calculation Time: The time at which to calculate head/drawdown versus distance data. 

Spreadsheet The data in the spreadsheet reflect the calculated data points.  If Custom has been 
selected on the Line tab, you can edit the number lines and the values of  the dis-
tances at which to calculate; if Custom was not selected, any changes made will be 
ignored. 
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View Manipulation 
Selecting the 3D Manipulation menu from the edit field context menu allows the manipulation of the 3D view 
using the mouse and keyboard.  Clicking and/or holding the left mouse button in the view causes the display to 
rotate in the direction toward the cursor location.  Holding the Shift  button while clicking and/or holding the 
left mouse button causes the display to move in the direction toward the cursor location.   
Clicking and/or holding the right mouse button causes the display to zoom in and zoom out.  If the cursor is in 
the upper half of the view, it will zoom out.  If the cursor is in the lower half of the view, it will zoom in.  The 
amount of the zoom is controlled by how far the cursor is from the vertical center of the view. 
 
The Reset 3D menu is used recenter the 3D perspective view.  This is sometimes required when changes have 
been made via the Contour Options property sheet or on screen editing. 
 
Contour Options 
Four tabs on the Contour Options property sheet apply to the 3D view and are described below.  The color 
flood parameters apply to both the contour view and the 3D view. 
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3D Mesh  

Vertical Scale Factor: A multiplier applied to head/drawdown to increase the vertical scale 
relative to the horizontal scale 

Color Bar: Controls the presence and location of the default scale bar 

Display X: The x-coordinate of the lower left corner (vertical) or upper right 
corner (horizontal) of the scale bar 

Display Y: The y-coordinate of the lower left corner (vertical) or upper right 
corner (horizontal) of the scale bar 

Contour Plane  

View Contours: When checked, a contour map is displayed in the 3D perspective 
view 

Color: Controls the color of the contours which can be either Black or 
Flood Colors 

Automatic Elevation: Controls the elevation on the vertical axis which corresponds to the 
contour plane; when checked the contour map will automatically be 
relocated as the contour data changes  

Specified Elevation: Controls the elevation on the vertical axis which corresponds to the 
contour plane; when checked, the value entered in the adjacent edit 
field will be used to locate the contour plane 

Reset 3D View At times, the perspective drawing can leave the field of view.  
Checking this option will relocate it into view 
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Cost: Professional Version  $550  Upgrade from Version 2:  $250 
 Modeling Version $750  Upgrade from Version 2:  $250 
 
 Winflow/Wintran $450  Upgrade from Winflow V2: $250 
 
Note: We are discontinuing the standard and slug test versions and have reduced the price of the Profes-
sional and Modeling Versions.  If you currently own the standard or slug test versions for Version 2, you 
will still only pay $250 to upgrade to the Professional Version 3.  
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